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Chapter 1. Introduction

Hyper-V is the next-generation server virtualization technology from Microsoft,1 replacing 
Microsoft Virtual Server. This technology is available in the following ways:

� As a stand-alone product called Hyper-V Server 2008
� Embedded into all of the three editions of Windows Server® 2008

In addition, when using Windows Server 2008, you can choose to install the full Windows 
Server product with all services and a graphical interface. Alternatively, you choose to install 
only the core services and the Hyper-V feature with only a text interface. The latter method is 
referred to in this paper as a Server Core installation. 

This chapter includes the following topics:

� 1.1, “Comparing the versions” on page 2
� 1.2, “Benefits” on page 3
� 1.3, “Hyper-V terminology” on page 4
� 1.4, “Different types of virtualization architectures” on page 5
� 1.5, “Windows hypervisor” on page 8
� 1.6, “Hyper-V Server 2008” on page 9
� 1.7, “Windows Server 2008: Server Core installation” on page 10
� 1.8, “Integration components” on page 11
� 1.9, “Scalability on System x” on page 12
� 1.10, “High availability on System x” on page 12
� 1.11, “Guest operating systems in Hyper-V” on page 13

1

1  Portions of this paper are from Microsoft Corporation. Used with Permission.



2 Implementing Microsoft Hyper-V on IBM System x and IBM BladeCenter

1.1  Comparing the versions

Table 1-1 compares the four ways in which Hyper-V is available to customers.

Table 1-1   Comparison of the ways in which Hyper-V is available 

For further information about Hyper-V Server beyond this paper, see the Microsoft Hyper-V 
Server 2008 page at the following address:

http://www.microsoft.com/servers/hyper-v-server/ 

For information about Windows Server 2008, see the Windows Server 2008 page at the 
following address:

http://www.microsoft.com/windowsserver2008/ 

Virtualization needs Microsoft 
Hyper-V Server 
2008

Feature of 
Windows 
Server 2008 
Standarda

a. This refers to both the full Windows Server installation and the Server Core installation.

Feature of 
Windows 
Server 2008 
Enterprisea

Feature of 
Windows 
Server 2008 
Data Centera

Server consolidation Yes Yes Yes Yes

Test and development Yes Yes Yes Yes

Mixed operating system 
virtualization (Linux® and Windows)

Yes Yes Yes Yes

Local GUI Yes Yes Yes

High availability - clustering Yes Yes

Quick migration Yes Yes

Large memory support (host 
operating system) > 32 GB RAM

Yes Yes

Support for > 4 processors (host 
operating system)

Yes Yes

Ability to add additional server roles Yes Yes Yes

Guest virtualization rights included 
in the host server license

None; each 
Windows guest 
virtual machine 
(VM) requires a 
license

1 physical + 
1 VMb

b. Each additional Windows guest VM requires a license.

1 physical + 
4 VMsb

1 physical + 
unlimited VMsc

c. Windows Server Data Center is licensed on a “per processor” basis and does not require additional Windows 
Server licenses for guest VMs.

http://www.microsoft.com/servers/hyper-v-server/
http://www.microsoft.com/windowsserver2008/
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1.2  Benefits

Hyper-V includes the following benefits:

� Quick migration

Quick migration enables the movement of running VMs from one host to other host 
servers with minimal downtime.

� High availability

Hyper-V includes support for host-to-host connectivity (two or more hosts, 16 maximum) 
and enables you to cluster all VMs running on a host.

� Server Core role

Hyper-V is now available as a role in a Server Core installation of Windows Server 2008. 
Windows Server 2008 can be installed in GUI mode and Server Core mode. Hyper-V is 
available as a role in either of these modes, regardless of the installation method that is 
chosen. 

Note that Hyper-V is not automatically installed. You must select the Hyper-V feature to 
install it.

Hyper-V Server is available at no charge on the Web. It installs with a limited core that 
includes only the services that are needed to support Hyper-V. A small text-based console 
is also provided.

� Integrated into Server Manager

Hyper-V is integrated into Server Manager by default and customers can now enable the 
role within Server Manager. Hyper-V is one of many roles that can be added to a base 
installation of Windows Server 2008 by using Server Manager. (Other traditional roles 
include Dynamic Host Configuration Protocol (DHCP) and Internet Information Server 
(IIS).)

� Live Backups with Volume Shadow Copy Services (VSS)

Hyper-V includes support for VSS to enable you to take Live Backups of running VMs in 
terms of snapshots.

� Virtual hard disk (VHD) tools

Hyper-V also includes support for VHD tools to enable compaction, expansion, and 
inspection of VHDs that are created with Hyper-V.

� VM manageability

With VM manageability, customers can easily import or export VM settings to take 
backups of configurations and clone the VM characteristics across different hosts.

� Remote management

Hyper-V supports remote management and provides a Hyper-V Microsoft Management 
Console (MMC) only installation option for a separate management node. Another option 
is by using Remote Desktop Protocol (RDP) to connect to the machine console over the 
network.

� Increased virtual Small Computer System Interface (SCSI) support

Hyper-V now includes support for up to four virtual SCSI controllers per VM enabling 
broader disk support.

� Increased memory support

Hyper-V supports up to 64 GB of memory per VM.
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� Quick reset

Hyper-V provides administrators the option to quickly reset check boxes and delete saved 
credentials that are used to connect to VMs.

As stated earlier in this chapter, Hyper-V is available as a standalone product, a Hyper-V 
Server, or integrated into three editions of Windows Server 2008. 

Usage of Hyper-V integrated into Windows Server 2008 includes the following benefits:

� It provides the use of a GUI. This is the biggest benefit for most virtualization users and is 
not included in Hyper-V Server.

� Standardizing on full Windows Server 2008 installations only simplifies systems 
management, because each Windows Server 2008 system has all of the same tools and 
consoles as every other server.

� Full installation reduces IT administrator training, because Hyper-V Server is a new 
environment that can have a steeper learning curve.

However, running Hyper-V Server over the Hyper-V feature of Windows Server 2008 includes 
the following benefits:

� Reduced attack surface

Because Hyper-V Server installations are minimal, fewer applications run on the server, 
which decreases the attack surface.

� Reduced management

Because fewer applications and services are installed on a server running Hyper-V 
Server, there is less to manage.

� Less disk space required

Hyper-V Server requires only about 1 GB of disk space to install and approximately 2 GB 
for operations after the installation.

� Hyper-V Server supports all of the Windows infrastructure roles: 

– DHCP
– Domain Name System (DNS)
– File and print
– Active Directory® Domain Services (AD DS)
– Read-only Domain Controller (RODC)
– Active Directory Lightweight Directory Services (AD LDS)
– Windows Media® Services (WMS)
– Internet Information Server 7.0

A full Windows Server 2008 installation must be chosen when the server will host 
applications such as SQL Server® and Exchange.

1.3  Hyper-V terminology

In this section, we define Hyper-V-related terminology. The following list of terms helps to 
define some components or functions in a Hyper-V system:

Parent partition In Hyper-V, the partition that manages the configuration of the 
hypervisor and system resources. All operating systems that run on a 
hypervisor server have allocated hardware resources that include 
RAM, CPU, and other system components. When the Hyper-V role is 
configured and the server is rebooted, the Windows Server 2008 
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installation that was the native operating system on the system 
becomes the operating system in the parent partition of the Hyper-V 
server.

Child partition An isolated environment on a Hyper-V server that is configured to hold 
a guest operating system and to provide hardware resources to that 
operating system.

Hyper-V host The physical server that is hosting Hyper-V and the operating system 
running inside the parent partition.

Hyper-V virtual machine
The Hyper-V configuration information and the data that is used to 
boot and run a Hyper-V child partition. This includes the configuration 
information to create the child partition and the VHD files or 
pass-through disks that contain its data.

Passthrough disk A storage device that is exposed in disk management as a physical 
disk assigned for exclusive use by a Hyper-V guest. The Hyper-V 
guest mounts the disk and uses it similar to a locally connected 
storage device.

Virtual hard disk (VHD) 
A file that is connected to by a Hyper-V child partition that is exposed 
to the operating system as a storage device (disk). The .vhd file is on a 
storage device that is mounted by the parent partition and can be a 
direct attached storage device, or storage that is connected to over a 
storage area network (SAN), network-attached storage (NAS), or 
Server Message Block (SMB).

For a more detailed and up to date list, see the Microsoft Developer Network (MSDN®) page 
at the following address:

http://blogs.msdn.com/virtual_pc_guy/archive/2008/02/25/hyper-v-terminology.aspx 

1.4  Different types of virtualization architectures

The characteristics of current computer hardware virtualization technology vary significantly. 
In this section, we introduce the three basic types of virtualization products available. 

Central to virtualization is the Virtual Machine Manager (VMM). The VMM is responsible for 
monitoring and enforcing policy on the VMs for which it is responsible. This means that the 
VMM keeps track of everything that happens inside of a VM. When necessary, it provides 
resources, redirects the VM to resources, or denies access to resources.

http://blogs.msdn.com/virtual_pc_guy/archive/2008/02/25/hyper-v-terminology.aspx
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Type-1 virtualization architecture
Figure 1-1 shows the type-1 architecture.

Figure 1-1   Type-1 architecture

Type 1 hypervisors are typically the preferred approach because they can achieve higher 
virtualization efficiency by dealing directly with the hardware. Type-1 hypervisors provide 
higher performance efficiency, availability, and security. Microsoft Hyper-V, VMware ESX, and 
Xen are examples of Type-1 architectures. 

Type-2 virtualization architecture
Figure 1-2 shows the Type-2 architecture. The Type-1 and Type-2 VMM architectures are the 
two approaches that are most widely used today.

Figure 1-2   Type-2 architecture

The Type-2 VMM is a stage where the VMM runs alongside the host operating system and 
helps to create VMs on top. Examples of the Type-2 VMM are Microsoft Virtual Server, 
Microsoft Virtual PC, VMware Workstation, and VMware Player. This kind if implementation is 
applicable in scenarios where VMs are not heavily loaded or resource-intensive.

Type-2 hypervisors are used mainly on client systems where efficiency is less critical. Type-2 
hypervisors are also used mainly on systems where support for a broad range of I/O devices 
is important and can be provided by the host operating system. 
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Application virtualization architecture
A third VMM architecture is exemplified by Java™ virtual machines (JVMs) or .NET 
architecture and can be considered more of an application framework than a hypervisor 
(Figure 1-3). Here, the goal of virtualization is to create a runtime environment within which 
the process can execute a set of instructions without relying on the host system. In this case, 
the isolation is for the different processes. It allows a single application to run on different 
operating systems without having to worry about operating system dependencies. This is not 
actually a server virtualization category.

Figure 1-3   Application framework architecture

Table 1-2 lists some of the hypervisors that are available and the IBM systems on which they 
run. 

Table 1-2   Available hypervisors

For more details about Hyper-V architecture, see the article at the following address from the 
MSDN:

http://msdn.microsoft.com/en-us/library/cc768520.aspx 

Hypervisor Hypervisor type IBM systems that run hypervisor

Microsoft Hyper-V Type 1 IBM System x and BladeCenter 

POWER® Type 1 IBM System i® and System p®

Processor Resource/System Manager Type 1 IBM System z®

VMware ESX Type 1 System x and BladeCenter

Xen Type 1 System x and BladeCenter

z/VM® Type 1 System z

VMware Server Type 2 System x and BladeCenter

Microsoft Virtual Server Type 2 System x and BladeCenter 

Microsoft Virtual PC Type 2 System x and BladeCenter 

VMware Player Type 2 System x and BladeCenter 

VMware Workstation Type 2 System x and BladeCenter 
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1.5  Windows hypervisor

Ensuring that there is strong separation between multiple operating systems is done by 
creating virtual processors, memory, timers, and interrupt controllers. Operating systems use 
these virtual resources just as they might use their physical counterparts.

The Windows hypervisor in Hyper-V performs the following tasks:

� Creates logical partitions
� Manages memory and processor scheduling for guest operating systems
� Provides mechanisms to virtualize input/output and communicate among partitions
� Enforces memory access rules
� Enforces policy for CPU usage
� Exposes a simple programmatic interface known as hypercalls

Because it uses the microkernelized approach, the Windows hypervisor is fairly small (less 
than 1 MB in size). This minimal footprint helps to improve the overall security of the system. 
Figure 1-4 compares the microkernelized kernel that is used in Hyper-V with a monolithic 
hypervisor. A monolithic hypervisor is an architecture that has its own operating system 
kernel and driver model, and requires driver support from the hardware vendors. An example 
is VMware ESX.

Figure 1-4   Comparing a monolithic hypervisor with a microkernelized hypervisor

A monolithic hypervisor has the following features: 

� Is simpler than a modern kernel, but is still complex
� Contains its own drivers model

A microkernelized hypervisor has the following features: 

� Simple partitioning functionality

� Small trusted computing base (TCB), which is the portion of code that is allowed to run in 
privileged mode

� No third-party drivers

� Drivers that run within guests

One of the requirements for running Hyper-V is having a x64 platform that has Intel® VT or 
AMD™-V™ technologies. x64 technology enables access to a larger address space and 
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support for systems with more memory. This way allows many more VMs on one host. Intel 
VT and AMD-V are hardware-assisted virtualization solutions that provide a layer in the ring 
architecture that helps to keep the execution environment of the hypervisor separate from the 
rest of the system. Intel VT and AMD-V technology also allow Hyper-V to run an unmodified 
guest operating system without a significant decrease in emulation performance.

1.6  Hyper-V Server 2008

Hyper-V Server is a dedicated standalone product. It is available for download at no charge 
from Microsoft at the following address:

http://www.microsoft.com/servers/hyper-v-server 

Hyper-V Server 2008 supports up to four processor sockets and 32 GB or RAM. Hyper-V 
Server 2008 contains only the Windows hypervisor and the virtualization components. It 
cannot be used in any other purpose. 

Some of the constraints are the scalability and performance aspects. There is no high 
availability, nor are quick migration features available in this product. Performance constraints 
are almost equal with Windows Server 2008 except that Windows Server can be used for 
other purposes and is available. 

Microsoft Hyper-V Server uses the same VM model as Windows Server 2008 with Hyper-V 
enabled. Therefore, there is no need to re-tool your management infrastructure. 

Hyper-V Server provides the following support:

� VHD format

To move a VM from Hyper-V Server to a Windows Server 2008 Hyper-V environment (or 
vice versa), simply export the VM and import it on the other host by using the standard 
management tools.

� BitLocker™ support

Hyper-V Server can take advantage of BitLocker technology to encrypt a Hyper-V Server 
so that, even if the hardware is stolen and the hard disks are removed, the data is 
inaccessible. This is particularly useful for branch offices or environments where physical 
security is a concern.

� Live Backup support

Hyper-V Server includes native support for Volume Shadow Services so that it can provide 
Live Backup of running VMs without downtime.

� Flexible hardware support

Hyper-V Server uses the Windows Server driver model and is compatible with a wide 
variety of server hardware and driver support for newer peripherals such as a 10 Gb 
Ethernet.

� Flexible storage

Hyper-V Server offers flexible storage support, such as the following examples:

– Direct Attach Storage (DAS) protocols: SATA, eSATA, PATA, SAS, SCSI, USB, Firewire
– SAN protocols: iSCSI, Fibre Channel, SAS
– NAS

� Virtual machine snapshots

Hyper-V Server fully supports VM snapshots.

http://www.microsoft.com/servers/hyper-v-server
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� VSP, VSC, and VMBUS

Both Hyper-V Server and Windows Server 2008 fully use the VSP, VPC, and VMBus 
driver architecture for high performance I/O. There is no conversion when moving VMs 
between Microsoft Hyper-V and Windows Server 2008.

Hyper-V Server offers the following support on the parent partition:

� Support for systems with up to 4 processors 
� Support for systems with up to 32 GB of physical memory
� Support for up to 128 VMs 

Hyper-V Server offers the following support for VMs:

� 32-bit (x86) and 64-bit (x64) VMs

� Up to 4 virtual processors per VM

� Up to 31 GB memory for all running VMs (1 GB is reserved for Hyper-V Server parent 
partition.)

1.7  Windows Server 2008: Server Core installation

As we mentioned earlier, you can install Windows Server 2008 either with all services and a 
graphical interface, or you can install the “Server Core” with primarily a textual interface and 
only the needed services. You select whether you want the normal full installation of Windows 
Server 2008 or the core installation early in the installation process. 

Hyper-V is not installed by default. You must use the command line to install Hyper-V and any 
other subsystems and features that you require. 

The following graphical tools remain in the core version:

� Notepad (although a slightly cut-down version)
� Task manager
� Time zone, time, and date applet
� Regional settings applet

All other features are managed by using either the command line interface or the remote 
management toolset.

Important: The type of installation that you choose is final. There is no option to upgrade 
from a core installation to a full installation or to perform the reverse. 

Tip: The Server Core installation of Windows Server 2008 and Hyper-V Server 2008 look 
similar in that they both have a text-only interface. However, the Server Core installation 
has more features as listed in Table 1-1 on page 2. Hyper-V Server 2008 is actually a 
subset of the Server Core installation, with Hyper-V already enabled.
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The following arguments favor a Server Core installation over a full Windows Server 
installation:

� More secure

A stripped down operating system runs fewer applications. Consequently, there are fewer 
opportunities to exploit weaknesses in these applications.

� Less maintenance

Fewer components to maintain (patch) can lead to less planned downtime. Microsoft 
claims 40% fewer patches, where other options show slightly less but still significant 
reductions.

� Lower resource overhead

There is a smaller memory and disk footprint. This argument is not particularly significant 
given the percentage of savings on modern hardware configurations.

� Less chance of software bugs.

This argument seems self-evident because there are fewer running components. 
However, there is a counter to this. If the core installation is primarily used under Hyper-V, 
which is already only a minor subset of Windows 2008 installations, then the population of 
core users is significantly smaller than those running the full fat version. If you are in a 
smaller user community, by inference, there is less user testing and consequently a 
greater risk of encountering an error that is specific to your environment. 

The Server Core version has the following issues: 

� Some system management tools might not install or function correctly under a core 
installation.

To be installable in the core installation, systems management tools must offer an 
unattended or command-line installation option. Additionally a number of APIs are not 
available under the core installation. It might be worthwhile to check with your software 
vendor if their product has been tested under this environment.

� Lack of familiarity

The Windows 2008 full version requires no additional training over its 2003 parent. The 
look and feel of the toolsets are intuitive to the person who is using them. The core 
version, even if only initially, requires the person who is installing it to consult the manual.

1.8  Integration components

Hyper-V was built to provide strong boundaries between various instances running on one 
server. To enable interaction between the guest operating system and the host operating 
system and to supply additional functionality for supported guest operating systems, Hyper-V 
provides integration components.

The Hyper-V integration components have the following features:

� Time synchronization
� Volume Shadow Copy Service
� Heartbeat functionality
� Guest shutdown
� Key value pair exchange (used to access the registry of a guest operating system)
� Operating system identification
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1.9  Scalability on System x

By using the microkernelized hypervisor architecture, Hyper-V has low CPU overhead, which 
leaves plenty of room to virtualize workloads. By enabling VMs to take advantage of the 
powerful features of the System x hardware, such as multicore technology, disk access, and 
greater memory, Hyper-V improves scalability and performance of the virtualization platform.

Combined with the rest of the Windows Server 2008 capabilities, with Hyper-V, you can 
consolidate most workloads on a single system. It can also help you balance 64-bit 
technology adoption with continued support for 32-bit workloads that are already used 
throughout your environment.

The fact that Hyper-V requires a 64-bit host system with hardware-assisted virtualization 
helps ensure that the host system has access to a large pool of memory resources. Hyper-V 
can support up to 1 TB of memory on the host, with up to 64 GB of memory per VM (with 
Windows Server 2008 Enterprise and Data Center Editions). This support is key for those 
who plan to virtualize memory-intensive workloads such as Exchange Server and SQL 
Server.

With the installation of fix KB956710,2 Hyper-V also supports up to 24 logical processors on 
the host system. This makes Hyper-V scalable to most commodity two-socket and four-socket 
systems with multiple cores. You can also create a VM with up to four virtual processors to 
support workloads that require or take advantage of multi-processor capabilities.

When planning scalability options with Hyper-V, clustering solutions are available for certain 
Hyper-V implementations. Implementing Hyper-V scale-out solutions are not out of scope, but 
are harder to implement because of the slower response of Quick Migration and the Microsoft 
shared-nothing storage model used in clustering.

1.10  High availability on System x

Hyper-V has a low CPU overhead, leaving plenty of room to virtualize workloads. By enabling 
VMs to take advantage of powerful features and hardware, such as multicore technology, 
improved disk access, and greater memory, Hyper-V improves scalability and performance of 
the virtualization platform. 

Consolidating servers through Hyper-V also enables those servers to use robust networking 
support, including virtual local area network (VLAN), Network Address Translation (NAT), and 
Network Access Protection (NAP) policies (quarantine). As a Windows Server 2008 feature, 
Hyper-V works well with other Windows Server features, such as BitLocker and Windows 
PowerShell™.

More information: For more information about tuning SQL Server 2008 on System x 
hardware, see the IBM Redpapers publication Running Microsoft SQL Server 2008 on the 
IBM System x3950 M2, REDP-4476.

2  Patch number KB956710 was released shortly after general availability to support six-core processors, taking the 
total logical processor count to 24 supported cores. For more information, see the following address: 
http://support.microsoft.com/kb/956710 

http://support.microsoft.com/kb/956710
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1.11  Guest operating systems in Hyper-V

The following operating systems can be installed as guests running under Hyper-V:

� Windows Server 2008 x86/x64
� Windows Server 2003 x86/x64 SP2
� Windows 2000 Server SP4 and Advance Server SP4 x86/x64
� Windows HPC Server 2008
� SUSE® Linux Enterprise Server 10 SP1/SP2 x86/x64
� Windows Vista® SP1 (excluding Home Edition)
� Windows XP Professional SP2/SP3/X64
� Red Hat® Enterprise Linux
� Sun™ Solaris™

For a complete list of supported guest operating systems, see the following address:

http://support.microsoft.com/kb/954958 

Additional software, called Integration Services, can be installed on the following guest 
operating systems to provide driver support and performance enhancements: 

� Windows Server 2008
� Windows Server 2003 SP2
� Windows XP SP3
� Windows Vista SP1
� Linux SUSE SP1/SP2

We describe Integration Services in 2.5.3, “Installing Integration Services on the guest” on 
page 54.

http://support.microsoft.com/kb/954958
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Chapter 2. Installing and configuring 
Hyper-V

In this chapter, we explain the different ways to set up a virtualization environment by using 
Microsoft Hyper-V.

This chapter includes the following topics:

� 2.1, “System hardware requirements” on page 16
� 2.2, “Installing Hyper-V in Windows Server 2008: Server Core” on page 16
� 2.3, “Installing Hyper-V in Windows Server 2008: Full installation” on page 23
� 2.4, “Installing Hyper-V Server” on page 32
� 2.5, “Creating a virtual environment by using Hyper-V” on page 44

2
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2.1  System hardware requirements

To run Hyper-V, you must have the following hardware requirements:

� Processors: These include virtualization hardware assists from Intel (Intel VT) or AMD 
(AMD-V). To enable Intel VT, enter System Setup and navigate to Advanced Options → 
CPU Options and select the Enable Intel Virtualization Technology option. AMD-V is 
always enabled.

� Processor cores: Minimum of 4 processor cores

� Memory: A minimum of 16 GB of RAM

� Ethernet: At least one physical network adapter. 

� Disk space: One volume with at least 50 GB of disk space and one volume with at least 
20 GB of space.

� BIOS: Enable the Data Execution Prevention option in System Setup. Navigate to 
Advanced Options → CPU Options and select the Enable Processor Execute Disable 
Bit option. Ensure that you are running the latest version of BIOS.

Server hardware is certified by Microsoft to run Hyper-V. To review the list of servers that are 
certified, go to the Windows Server Catalog at the following address:

http://go.microsoft.com/fwlink/?LinkID=111228 

Select Hyper-V and IBM from the categories on the left side. 

2.2  Installing Hyper-V in Windows Server 2008: Server Core

The Server Core option on Windows Server 2008 provides a subset of the features of 
Windows Server 2008 to help run supported server roles, including Dynamic Host 
Configuration Protocol (DHCP), Domain Name System (DNS), Active Directory, and Hyper-V, 
without the overhead of the full Windows installation. With the Server Core installation, the 
Windows setup program installs the files that are needed for the supported server roles. 

The benefits of enabling Hyper-V on a Server Core installation are that it helps reduce the 
attack surface (the scope of interfaces, services APIs and protocols that a hacker might use 
to attempt to gain entry into the software). As a result, it reduces management requirements 
and maintenance. 

Microsoft provides management tools to remotely manage the Hyper-V role and virtual 
machines (VMs). Hyper-V servers can be managed from Windows Vista or other Windows 
Server 2008 systems (both x86 and x64). You can download the management tools from the 
following address:

http://support.microsoft.com/kb/952627 

2.2.1  Windows Server 2008 core installation

The recommended way to install Windows Server 2008 on an IBM System x or BladeCenter 
server is to use IBM ServerGuide, which ships as a DVD with your server. Alternatively, you 
can download ServerGuide from the following address:

http://www.ibm.com/support/docview.wss?uid=psg1SERV-GUIDE 

http://go.microsoft.com/fwlink/?LinkID=111228
http://www.ibm.com/support/docview.wss?uid=psg1SERV-GUIDE
http://support.microsoft.com/kb/952627
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To use the ServerGuide DVD to configure and install all drivers needed for your systems and 
to launch the installation of the operating system: 

1. Insert the ServerGuide DVD, start the server, and boot the ServerGuide disk.

2. Choose the language you want to use.

3. Accept the license agreement.

4. In the Welcome to Server Guide window, select the version of Microsoft Windows Server 
2008 that you want to install. We selected Microsoft Windows Server 2008 x64 
Enterprise Edition. Select Perform Server Core Installation.

5. Set the date and time.

6. Optional: If your server includes a RAID controller, configure the RAID arrays as 
prompted. 

7. Create and format a partition for Windows Server 2008. Select the type and size for the 
boot partition.

8. Confirm your server configuration and hardware settings. ServerGuide copies files to your 
hard disk in preparation for the operating system installation.

9. After the file copy process is complete, insert the Windows Server 2008 DVD when 
prompted and click Next.

10.Follow the guide to install the Server Core installation of Windows Server 2008. 

2.2.2  Post installation steps

After completing the installation of Windows Server 2008, you must perform the following 
tasks, which are explained in the sections that follow:

� Setting the administrative password
� Setting the server’s computer name
� Setting the IP address of a network controller
� Activating the server
� Joining the server to a domain
� Enabling Remote Desktop for administration

Setting the administrative password
To set the administrative password: 

1. At the login page, press Ctrl+Alt+Del. 
2. For user name, type Administrator, and for password, leave it blank. 
3. When prompted by the system, type a new password and press Enter.
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Setting the server’s computer name
To change the computer name for the system, type the following command:

netdom renamecomputer %computername% /NewName:<new name>

In this command, <new name> is the name you want to change to. In the example in 
Figure 2-1, the new name is CORESERVER.

Figure 2-1   Changing the computer name 

Setting the IP address of a network controller
When setting the IP address of a specific network controller, you must know its ID. 

1. To set the IP address of a specific network controller, enter the following command:

netsh interface ipv4 show interfaces

Figure 2-2 shows the output.

Figure 2-2   Determining the IDs of the network interfaces 

2. Change the IP address of the selected controller to a static address: 

netsh interface ipv4 set address name="<ID>" source=static address=<StaticIP> 
mask=<SubnetMask> gateway=<DefaultGateway> 

Note the following explanation:

– <ID> is the number that corresponds to the network adapter that you want to change 
from the output of the show interfaces command in Figure 2-2.

– <StaticIP>, <SubnetMask> and <DefaultGateway> are the parameters you want to set.

In our lab, we used the command shown in Figure 2-3.

Figure 2-3   Command to set the IP address of interface 2

Microsoft Windows [Version 6.0.6001]
Copyright (c) 2006 Microsoft Corporation. All rights reserved.

C:\Windows\system32>netdom renamecomputer %computername% /NewName:CORESERVER 
This operation will rename the computer WINDOWS-84GEBH6
to CORESERVER.

Certain services, such as the Certificate Authority, rely on a fixed machine
name. If any services of this type are running on WINDOWS-84GEBH6, 
then a computer name change would have an adverse impact.

Do you want to proceed (Y or N)?
y

C:\Users\Administrator>netsh interface ipv4 show interfaces

Idx  Met   MTU   State        Name
---  ---  -----  -----------  ----------------
  2   20   1500  connected    Local Area Connection
  1   50 4292967295  connected    Loopback Pseudo-Interface 1
  3   20   1500  connected    Local Area Connection 2

C:\Users\Administrator>netsh interface ipv4 set address name="2" 
source=static address=9.42.170.242 mask=255.255.254.0 gateway=9.42.170.1
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3. Specify a DNS server by entering the following command:

netsh interface ipv4 add dnsserver name="<ID>" address=<DNSIP> index=1

In our lab, we entered the command shown in Figure 2-4.

Figure 2-4   Command to set the DNS server of interface 2

Activating the server
To active the server, enter the following command:

slmgr.vbs -ato

This command does not return any text, as shown in Figure 2-5.

Figure 2-5   Activating the server 

Joining the server to a domain
Join a domain by entering the following command:

netdom join <computerName> /domain:<DomainName> /userd:<username> /passwordd:*

In our lab, we used the command in Figure 2-6.

Figure 2-6   Joining a domain 

Reboot the server to complete the operation by entering the following command:

shutdown /r /t 0

C:\Users\Administrator>netsh interface ipv4 add dnsserver name="2" 
address=9.42.170.241 index=1

C:\>slmgr.vbs -ato

Syntax: The parameter is passwordd:* with “dd” and not password:* with just one “d.”

C:\Users\Administrator>netdom join CORESERVER /domain:test-itsolab.local 
/userid:Administrator /passwordd:* 
Type the password associated with the domain user:

The computer needs to be restarted in order to complete the operation.

The command completed successfully.
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Enabling Remote Desktop for administration
To enable Remote Desktop to allow remote administration, configure the firewall by using the 
command shown in Figure 2-7.

Figure 2-7   Configuring the firewall for remote administration 

2.2.3  Installing the Hyper-V role

Hyper-V is certified to run on specific IBM System x and BladeCenter models as explained in 
2.1, “System hardware requirements” on page 16. As an aid, you can confirm the operating 
system version and architecture by using the following commands:

wmic OS get OperatingSystemSKU
wmic OS get OSArchitecture

Figure 2-8 shows an example of the output of these commands.

Figure 2-8   Sample output of the commands to confirm that the operating system is installed

The output of the OperatingSystemSKU command is a number:

� 12 = Windows Server 2008 Data Center Edition Server Core
� 13 = Windows Server 2008 Standard Edition Server Core
� 14 = Windows Server 2008 Enterprise Edition Server Core

The OSArchitecture command confirms that the operating system is 64-bit. Hyper-V requires 
x64 (64-bit) support. 

Note: The group names in the command are case sensitive. 

C:\Users\Administrator>netsh advfirewall firewall set rule group="Windows Management 
Instrumentation <WMI>" new enable=yes 

Updated 4 rule(s).
Ok.
C:\Users\Administrator>netsh advfirewall set rule group="Remote Administration" new 
enable=yes 

Updated 3 rule(s).
Ok.
C:\Users\Administrator>

C:\>wmic OS get OperatingSystemSKU
OperatingSystemSKU
14

C:\>wmic OS get OSArchitecture
OSArchitecture
64-bit
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To install Hyper-V on Windows Server 2008 Server Core:

1. Install Windows Server 2008 fix KB950050:

wusa 100208-Windows6.0-KB950050-x64.msu /quiet /norestart

2. Confirm that the update package is installed on the system:

wmic qfe list

Figure 2-9 shows the output of this command, which indicates that KB950050 is installed.

Figure 2-9   Output of the wmic command showing that KB950050 is installed 

3. Install the Hyper-V role: 

start /w ocsetup Microsoft-Hyper-V

4. After a few moments, when you are prompted to restart the server, in the Windows 
Package Manager window (Figure 2-10), click Yes. 

Figure 2-10   Selecting the option to restart the server

5. Add the domain administrator (or another user) to the Distributed COM Users group to 
enable remote management of Hyper-V:

net localgroup "Distributed COM Users" /add test-itsolab.local\administrator

Figure 2-11 shows the output of this command.

Figure 2-11   Adding the domain administrator to the Distributed COM Users group

Note: This update must be installed on all Hyper-V installations. It replaces beta 
components that were included in the general availability (GA) release of Windows 
Server 2008 with the updates that were made available after the GA of Hyper-V.

C:\Users\Administrator>wmic qfe list
Caption                                    CSName      Descritpion  FixComments  
HotFixID  InstalledDate  InstalledBy                                    InstalledOn       
Name  ServicePackInEffect  Status
http://support.microsoft.com/?kbid=950050  CORESERVER  Update                    
KB950050                 S-1-5-21-3636808658-2890314771-1900119241-500  
01c945af0c362719

C:\>net localgroup "Distributed COM Users" /add test-itsolab.local\administrator
The command completed successfully.
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6. Enable Remote Desktop Protocol (RDP) connections (Remote Desktop Connection) to 
the server:

cscript c:\windows\system32\scregedit.wsf /ar 0

This command is the Server Core script equivalent of regedit. The /ar 0 parameter is 
used to enable RDP connections to the server. Figure 2-12 shows the output of this 
command.

Figure 2-12   Adding the domain administrator to the Distributed COM Users group

Hyper-V is now installed, and you can manage Hyper-V from a remote system. 

To manage Hyper-V from a Windows Vista SP1 system (32-bit or x64), you must first install 
fix KB941314 on that system. This fix installs the Microsoft Remote Server Administrative Tool 
package so that you can remotely manage roles and features in Windows Server 2008 from a 
computer running Windows Vista with Service Pack 1. For download information, see the 
following address:

http://support.microsoft.com/kb/941314 

After you install the fix, you can connect to the remote server:

1. Click Control Panel → Administrative Tools → Hyper-V Manager. 

2. Click Action → Connect. 

3. Enter the computer name of the system running Hyper-V core (Figure 2-13).

Figure 2-13   Connecting to the remote server running Hyper-V

C:\>cscript c:\windows\system32\scregedit.wsf /ar 0
Microsoft (R) Windows Script Host Version 5.7
Copyright (C) Microsoft Corporation. All rights reserved.

Registry has been updated

http://support.microsoft.com/kb/941314
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Now that the installation is complete, you can begin setting up the virtualization environment 
by using Hyper-V Manager as described in 2.5, “Creating a virtual environment by using 
Hyper-V” on page 44.

2.3  Installing Hyper-V in Windows Server 2008: Full installation

In this section, we describe the installation of Microsoft Windows 2008, Enterprise Edition, 
including Hyper-V, on an IBM System x3850 M2. The installation involves the following tasks, 
which are explained in the sections that follow:

1. Installing the base operating system by using IBM ServerGuide
2. Applying Microsoft updates
3. Adding the Hyper-V role to a server

2.3.1  Installing the base operating system by using IBM ServerGuide

The IBM ServerGuide tool simplifies the installation of an operating system, such as Windows 
Server 2008, on an IBM System x or BladeCenter server. ServerGuide includes all the 
necessary drivers (including boot drivers) and allows you to configure, for example, RAID 
arrays (if the server has a RAID controller). ServerGuide does not include the operating 
system itself. You must have the installation media and a valid license.

IBM ServerGuide ships on a CD with your server. However, we recommend that you 
download the latest version from the following address:

http://www.ibm.com/support/docview.wss?uid=psg1SERV-GUIDE 

To install Windows Server 2008, Enterprise Edition, by using ServerGuide:

1. Boot the server from the ServerGuide disk.

2. Set the keyboard layout and accept the ServerGuide license.

http://www.ibm.com/support/docview.wss?uid=psg1SERV-GUIDE
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3. In the operating system selection panel (Figure 2-14), select the operating system that you 
want to install. Since we are installing the full version (not the Server Core installation), 
leave the Perform Server Core Installation check box as cleared. Also ensure that the 
No HyperV option is clear. Click Next.

Figure 2-14   ServerGuide operating system selection panel

4. Continue with the next panels, setting the date and time, setting the RAID configuration, 
and creating and formatting the operating system partition. Click Next on the respective 
panels.
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5. When the ServerGuide process shows a summary of your selected settings (Figure 2-15), 
click Next to begin the installation process. ServerGuide starts by copying the appropriate 
device drivers to the hard disk partition.

Figure 2-15   ServerGuide summary panel prior to beginning the operating system installation

6. When prompted, remove the ServerGuide CD and insert the Windows Server 2008 DVD. 
The process then verifies the operating system installation media and launches the 
Windows installation process.
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7. Select the Windows language and preferences (Figure 2-16). Click Next.

Figure 2-16   Windows Server 2008 installation - national language selection

8. In the Microsoft license terms acceptance panel, accept the license terms to initiate the 
main Windows installation process. The necessary Windows installation files are copied to 
the disk drive in preparation for an unattended installation of the operating system.
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9. After the files are copied, in the final ServerGuide window (Figure 2-17), click Next.

Figure 2-17   ServerGuide installation complete
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The operating system installation is now complete, and no further action is required until the 
initial configuration task panel (Figure 2-18).

Figure 2-18   Windows Server 2008 initial configuration window

This completes the installation of the basic operating system.

2.3.2  Applying Microsoft updates

It is prudent to apply the latest Hyper-V related updates to the system before adding the role 
to the machine. The required update at the time at which this paper was written was 
KB950050. The KB950050 update must be installed on all Hyper-V installations. It replaces 
beta components that were included in the GA release Windows Server 2008 with the 
updates that were made available after GA of Hyper-V. 

You can download the KB950050 update from the following address:

http://support.microsoft.com/kb/950050 

Additionally, download and review the latest Hyper-V release notes from the following 
address:

http://www.microsoft.com/downloads/details.aspx?FamilyID=3ed582f0-f844-40ba-b692-2
30845af1149&displaylang=en 

http://www.microsoft.com/downloads/details.aspx?FamilyID=3ed582f0-f844-40ba-b692-230845af1149&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=3ed582f0-f844-40ba-b692-230845af1149&displaylang=en
http://support.microsoft.com/kb/950050
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2.3.3  Adding the Hyper-V role to a server

Adding the Hyper-V role to a server can be initiated from either the Initial Configuration Tasks 
window (Figure 2-18 on page 28) or the Server Manager. The Server Manager can be started 
by entering ServerManager.msc at a command prompt. Both panels have an “Add Roles” 
section.

You must have local administrator privileges to add a roles to a server. To add a role:

1. Click Add roles.

2. In the Before You Begin panel, click Next.

3. In the Select Server Roles panel (Figure 2-19), select Hyper-V. Click Next.

Figure 2-19   Select Server Roles panel
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4. In the next panel (Figure 2-20), which summarizes the Hyper-V role and indicates that you 
might have to select some BIOS features, click Next. There is no need to select BIOS 
features because no BIOS modifications were required when installing Hyper-v on the IBM 
x3850 M2.

Figure 2-20   Hyper-V introduction panel
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5. In the next panel (Figure 2-21), select the network cards to create virtual networks and for 
use by the Hyper-V guests. Microsoft recommends (as stated in the panel) that you 
reserve one card for remote access, and not for virtual networking. Click Next.

Figure 2-21   Creating virtual networks

6. In the confirmation panel, click Install to start the Hyper-V installation process.

7. After the installation is complete, reboot the server as prompted. 
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At the end of the process, the Hyper-V role is displayed in the list of installed roles in Server 
Manager, as shown in Figure 2-22. 

Figure 2-22   Server Manager showing that Hyper-V is now installed

Now that the installation is complete, you can begin setting up the virtualization environment 
as explained in the following section.

2.4  Installing Hyper-V Server

As we explained in Chapter 1, “Introduction” on page 1, Hyper-V Server 2008 is available as a 
free download from the Microsoft Web site. Hyper-V Server 2008 is a subset of Windows 
Server 2008 Standard Edition and can only be installed in console (Server Core) form. 

Hyper-V Server 2008 can only be a hypervisor and cannot take on any of the other traditional 
server roles such as Active Directory, DHCP, DNS, and so on. In addition, Hyper-V Server 
2008 has the following limitations among others:

� Supports a maximum of 32 GB or RAM 
� Four sockets of CPU 
� No clustering support or Quick Migration
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2.4.1  Downloading and installing Hyper-V Server

You can download Hyper-V Server from the following address:

http://www.microsoft.com/servers/hyper-v-server/ 

After you have the image and burn it to a DVD, insert the DVD into the desired system and 
boot up the system. Then complete the following steps:

1. Select the language option and confirm your selection.
2. Select Start Install.
3. Accept the license terms and conditions.
4. Select Disk Partition for Installation.

The installation begins and completes with no further input.

At the login window, enter a new administrative password for the system. You must set the 
administrative password after the operating system completes the installation.

1. Press Ctrl+Alt+Del.
2. Type Administrator but no password.
3. When the system prompts you for a new password (Figure 2-23), enter the password. 

Figure 2-23   Prompt for a new administrator password

http://www.microsoft.com/servers/hyper-v-server/
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When you log on to Hyper-V Server, it looks similar to a Server Core installation of Windows 
Server 2008, but there is one key difference. It has both a command line console and a 
command prompt as shown in Figure 2-24. We review these options and remote 
management options later in this chapter.

Figure 2-24   The console window and command prompt of the main user interface for Hyper-V Server

2.4.2  Console management

Management of Hyper-V Server must be done by using either the Hyper-V Configuration 
console (hvconfig console) that is presented when you log in (Figure 2-24), the command 
line, or remotely. By using the console and command line, you can make the initial system 
settings that are necessary to configure your system and allow it to be managed remotely. 

The command console starts automatically when you log in. The command console provides 
the administrator with basic setup and configuration options that are most commonly used. To 
use a command in the console, simply select the number of the item that you want to execute 
and enter it at the prompt. You are then prompted though that change and return to the 
console when it is completed. 

The following options are available as shown in Figure 2-24:

� Domain/Workgroup (to join a domain)
� Computer Name (to change your computer name)
� Network Settings (for you to set your host network addresses)
� Add Local Administrator
� Windows Update Settings
� Download and Install Updates
� Remote Desktop (settings)
� Regional and Language Options
� Date and Time (for the system)
� Log Off User
� Restart Server

C:\Windows\system32\cmd.exe

Hyper-V Configuration

Workgroup:   WORKGROUP
WIN-SQ13VWBA5VS
No active network adapters found.

Manual
Last manual check: Unknown
Disabled

1> Domain/Workgroup:
2> Computer Name:
3> Network Settings
4> Add Local Administrator

5> Windows Update Settings:
6> Download and Install Updates:
7> Remote Desktop:

8> Regional and Language Options
9> Date and Time

10> Log Off User
11> Restart Server
12> Shut Down Server

13> Exit to Command Line

Enter number to select an option: _

C:\Windows\system32\cmd.exe

Hyper-V Configuration

Workgroup:   WORKGROUP
WIN-SQ13VWBA5VS
No active network adapters found.

Manual
Last manual check: Unknown
Disabled

1> Domain/Workgroup:
2> Computer Name:
3> Network Settings
4> Add Local Administrator

5> Windows Update Settings:
6> Download and Install Updates:
7> Remote Desktop:

8> Regional and Language Options
9> Date and Time

10> Log Off User
11> Restart Server
12> Shut Down Server

13> Exit to Command Line

Enter number to select an option: _
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� Shut Down Server
� Exit to Command Line

All other changes to the system, including the setup, configuration, and managing of VMs, 
must be done remotely or by using the command line. 

If you close the console, you can open it again by typing the following command:

hvconfig

If you accidentally close all of the console windows, you can open new ones by running 
Windows Task Manager:

1. Press Ctrl+Alt+Del and click Start Task Manager. 

2. To open a new command prompt window, click File → New Task (Run).

3. In the Create New Task window (Figure 2-25), enter cmd.

Figure 2-25   Opening a new command prompt window
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Setting an IP address for a host partition
By using the console utility, you can view and configure your network interfaces. If using static 
IP addresses, make sure that you also set your DNS and Gateway addresses.

When possible, leave one network interface for dedicated host management and one or more 
dedicated for Hyper-V guest VMs. Figure 2-26 shows the options to configure a network 
interface.

Figure 2-26   Configuring a network interface

Administrator: C:\Windows\system32.cmd.exe

C:\Users\Administrator>start cmd

C:\Users\Administrator>

Administrator: C:\Windows\system32.cmd.exe - hvconfig
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Select Network Adapter Index# <Blank=Cancel>:  1

--------------------------------
Network Adapter Settings

--------------------------------
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Description              Intel 21140-Based PCI Fast Ethernet Adapter <Emulated>
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Subnet Mask              255.255.0.0
DHCP enabled             True
Default Gateway
Preferred DNS Server
Alternate DNS Server

1> Set Network Adapter IP Address
2> Set DNS Servers
3> Clear DNS Server Settings
4> Return to Main Menu

Select an option: _

Administrator: C:\Windows\system32.cmd.exe

C:\Users\Administrator>start cmd

C:\Users\Administrator>
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--------------------------------
Network Adapter Settings

--------------------------------

NIC Index                1
Description              Intel 21140-Based PCI Fast Ethernet Adapter <Emulated>
IP Address               169.254.168.220
Subnet Mask              255.255.0.0
DHCP enabled             True
Default Gateway
Preferred DNS Server
Alternate DNS Server

1> Set Network Adapter IP Address
2> Set DNS Servers
3> Clear DNS Server Settings
4> Return to Main Menu

Select an option: _
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Running Windows Update
To spare you the frustration of running into issues that have been found and fixed, run 
Windows Update to ensure that all applicable patches are on your host server. 

To start Windows Update manually, from the Hyper-V Configuration window, type 6 for 
Download and Install Updates (Figure 2-24 on page 34). You can also configure the settings 
for Windows Update by typing option 5 from the menu.

If you have a firewall that must be authenticated through, try a command line FTP or TELNET 
connection to a known site (Figure 2-27). Several third-party tools are available on the Web 
that you can use to perform this action. 

Figure 2-27   Running Windows Update manually
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Setting a host computer name
By using the console, you can change the host computer name (Figure 2-28). You must do 
this before you join any domain to reduce chances of errors and confusion. 

Figure 2-28   Setting a new computer name

Joining the host computer to a domain
Hyper-V Server 2008 can also be a member of a domain. Once again, the console is used to 
join the host to the specified domain (Figure 2-29). Reboot the server when the operation is 
completed. 

Figure 2-29   Changing the domain membership
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2.4.3  Using the command line

Windows Server 2008 has deep command-line support. Because Hyper-V Server is based on 
Windows Server 2008, it can take advantage of all the command-line tools that are available. 
Multiple books and online resources are available to assist you in managing your system by 
using a command line. 

The following subset of commands includes the ones that are most useful for making basic 
changes to the system to allow remote management of your Hyper-V Server 2008 system.

To see a list of drivers installed on your system, type the following command:

sc query type=driver

To perform an INF installation of a driver, type the following command:

pnputil –i –a <driver.inf>

To see your systems IP address, type the following command:

ipconfig /all

To configure the firewall to support remote management by using Microsoft Management 
Console (MMC), type the following command:

netsh advfirewall firewall set rule group="Remote Administration" new enable=yes

To discover a list of available server roles, type the following command:

oclist

To start a service, type the following command:

net start <service name>

To stop a service, type the following command:

net stop <service name>

2.4.4  Setting up for remote management

Certain tasks must be completed remotely, such as validating your driver versions and 
managing your VMs. You must complete the following tasks, as explained in the following 
sections, to properly enable your host platform to allow remote management:

1. Opening the firewall sufficiently to allow the Hyper-V Manager MMC to connect and 
operate remotely.

2. Enabling remote access to the PnP interface on the host platform.

Opening the firewall settings in Hyper-V Server 2008
To open the firewall settings to support remote management of Hyper-V with an MMC 
snap-in, enter the following command:

netsh advfirewall firewall set rule group="Remote Administration" new enable=yes
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By entering this command, three rules were successfully updated as shown in Figure 2-30. 

Alternatively, although not recommended, you can completely disable the firewall by typing 
the following command:

Netsh firewall set opmode mode=DISABLE profile=ALL

Figure 2-30   Configuring the firewall to allow remote management

Enabling remote access to the PnP interface in Hyper-V Server 2008
After configuring the Windows Firewall, remote access to the PnP interface must also be 
enabled. This can be done from a Windows Server 2008 system (full GUI installation) or a 
Windows Vista system.

From the remote system, open the Local Group Policy editor MMC snap-in and establish a 
connection to the system running Hyper-V Server. Navigate to Computer Configuration → 
Administrative Templates → System → Device Installation (Figure 2-31 on page 41). 
Enable the Allow remote access to the PnP interface setting.

Administrator: C:\Windows\system32.cmd.exe

C:\Users\Administrator>netsh advfirewall firewall set rule group="Remote Adminis
tration" new enable = yes

Updated 3 rule<s>.
Ok.

C:\Users\Administrator>

11> Restart Server
12> Shut Down Server

13> Exit to Command Line

Enter number to select an option:_

Administrator: C:\Windows\system32.cmd.exe

C:\Users\Administrator>netsh advfirewall firewall set rule group="Remote Adminis
tration" new enable = yes

Updated 3 rule<s>.
Ok.

C:\Users\Administrator>

11> Restart Server
12> Shut Down Server

13> Exit to Command Line

Enter number to select an option:_
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Figure 2-31   Allowing remote access to the PnP system

You must reboot the Hyper-V server to enable this policy.

If you have trouble locating the console snap-in:

1. Click Start → Run.

2. Enter mmc. 

3. When the MMC framework is running, click File → Add/Remove Snap-in (or Ctrl+M), and 
select Group Policy Object. 

4. When prompted, specify the remote Hyper-V server. 

If you are having permission problems accessing your server, make sure that Microsoft 
Updates have been installed and that you are logging into an account with administrator 
privileges on the Hyper-V Server. If necessary, you can use the Hyper-V Configuration 
console to create or add an account to the local administrator group.

2.4.5  Applying the IBM updates

Your must have installed the latest available drivers on your host server. When doing this 
installation, you must determine what is currently installed when the operating system first 
starts and what are the latest drivers available on the Web. 
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Determining the driver level
A quick and easy way to see installed devices and driver versions is to use the Device 
Manager. However, because Hyper-V is based on a core installation, again, you must do this 
remotely by using MMC.

After completing the steps to enable remote access to the PnP interface on a Hyper-V Server, 
start a basic MMC framework again. Press Ctrl+M to select Device Manager and select the 
remote Hyper-V Server system. 

Device Manager operates in a read-only mode, but from here, you can traverse the Hyper-V 
Server system devices, and see the respective driver levels (Figure 2-32). You can compare 
them against the latest driver levels that are available on the IBM support site. 

Figure 2-32   Viewing the devices on the remote Hyper-V Server system by using Device Manager

IBM update site
You must download and apply the latest drivers for the devices on your system from the IBM 
Support Web site. You can find the driver matrix for System x servers at the following address:

http://www.ibm.com/support/docview.wss?uid=psg1MIGR-4JTS2T 

Downloading and running updates
After you compile a list of drivers for your system, download the packages and place them in 
a temporary directory on your host system. If the download is an executable (.exe) file, then 
run that .exe file to launch the installer or to unpack the installation package. When the 
package starts, follow the instructions to install or update the driver. 

http://www.ibm.com/support/docview.wss?uid=psg1MIGR-4JTS2T
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Figure 2-33 shows the Broadcom driver being updated. 

Figure 2-33   Updating the Broadcom driver

If the downloaded update is simply an update to a driver (that is, without a setup.exe 
installer), you can enter the following command to perform an INF installation of the driver:

pnputil –i –a <driver.inf>

2.4.6  Managing the Hyper-V Server 2008 platform

The management of Hyper-V Server 2008 is limited to the basic management tool included 
with Windows Server 2008. This tool is an MMC snap-in and can be used to create host 
settings for your VM, as well as create, configure, and manage your VMs. An alternate 
management tool is System Center Virtual Machine Manager, which we describe in 3.2, 
“Microsoft System Center Virtual Machine Manager” on page 65. 
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Managing Hyper-V Server
A remote system must be used manage and administer the virtual environments of your 
Hyper-V systems. The Hyper-V Manager MMC (Figure 2-34) can be run on any Windows 
Server 2008 installed with the GUI or a Windows Vista system that has the Hyper-V Remote 
Management tools installed (available for download on the Web). We discuss this further in 
3.1, “Hyper-V Manager” on page 64. 

Figure 2-34   Hyper-V Manager

2.5  Creating a virtual environment by using Hyper-V

Now that the operating system is installed, you can create a virtualization environment, which 
includes creating a VM, creating a virtual network, and so on. 

Creating a virtual environment involves the following tasks, which are explained in the 
sections that follow:

1. Creating an initial virtual machine
2. Installing a guest operating system
3. Installing Integration Services on the guest
4. Installing a virtual network
5. Adding a virtual network adapter to a guest
6. Configuring a firewall for remote administration
7. Associating the Hyper-V administrator role with an AD group

Hyper-V Manager

File Action View Window Help

Hyper-V Manager
SCOTT08
HYPERVSVR

Virtual Machines

Snapshots

Name State CPU Usage Uptime Operators
Test1 Off

The selected virtual machine has no snapshots.

Test1

Created:  4/13/2009 2.09.24 PM

Nodes:    None

Actions

HYPERVSVR

New

Import Virtual Machine...

Hyper-V Settings...

Virtual Network Manager...

Edit Disk...

Inspect Disk...

Stop Service

Remove Server

Refresh

View

New Window from Here

Help

Connect...

Settings...

Start

Snapshot

Export...

Rename...

Delete...

Help

HYPERVSVR: 1 virtual machine selected.

Hyper-V Manager

File Action View Window Help

Hyper-V Manager
SCOTT08
HYPERVSVR

Virtual Machines

Snapshots

Name State CPU Usage Uptime Operators
Test1 Off

The selected virtual machine has no snapshots.

Test1

Created:  4/13/2009 2.09.24 PM

Nodes:    None

Actions

HYPERVSVR

New

Import Virtual Machine...

Hyper-V Settings...

Virtual Network Manager...

Edit Disk...

Inspect Disk...

Stop Service

Remove Server

Refresh

View

New Window from Here

Help

Connect...

Settings...

Start

Snapshot

Export...

Rename...

Delete...

Help

HYPERVSVR: 1 virtual machine selected.



Chapter 2. Installing and configuring Hyper-V 45

2.5.1  Creating an initial virtual machine

Virtual machines are created by using the Hyper-V Manager. To access the Hyper-V 
Manager, you can use either of the following options:

� Select Start → Administrative Tools → Hyper-V Manager. 
� Run servermanager.msc and then navigate to Roles → Hyper-V → Hyper-V Manager. 

Figure 2-35 shows the window that opens.

Figure 2-35   Hyper-V Manager

Either connect to the specific Hyper-V server from the action pane on the right side or click 
the specific server in the tree in the left pane (if listed).

To create a new VM on the selected server:

1. Click New → Virtual Machine to launch the New Virtual Machine wizard. 

2. In the Before You Begin panel, review the information and click Next. 
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3. In the Specify Name and Location panel (Figure 2-36), enter the name of the new VM and 
the location of the VM files. 

The folder for the location of the VM file should be considered primarily for performance. 
Significant amounts of free space can be consumed by VM snapshots, which are also 
placed by default at this location. However, their location can be modified later in the VM 
properties.

Click Next.

Figure 2-36   New Virtual Machine Wizard - Name and location
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4. In the Assign Memory panel (Figure 2-37), select the amount of memory to allocate to the 
VM. 

By default, 512 MB is allocated to a VM. However, for a Windows Vista guest, consider 
increasing this value to 1 GB or more for Windows Server 2008.

Click Next.

Figure 2-37   New Virtual Machine Wizard - Memory
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5. In the Configure Networking panel (Figure 2-38), specify the network adapter to use with 
this VM. The adapters listed are the ones that you selected in the panel shown in 
Figure 2-21 on page 31. Click Next.

Figure 2-38   New Virtual Machine Wizard - Networking
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6. In the Connect Virtual Hard Disk panel (Figure 2-39), specify the virtual hard disk to 
assign to the VM. You can either create a new virtual disk or select an existing one. The 
default allocation is 127 GB. Click Next.

Figure 2-39   New Virtual Machine Wizard - Virtual hard disks
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7. In the Installation Options panel (Figure 2-40), specify whether to install the operating 
system on the VM now or later. In our example, we install the operating system now by 
selecting the drive letter where the optical drive is.

Our drive D: is really the local optical drive on our remote management workstation. It is 
mapped as D: by using the Remote Supervisor Adapter II remote media feature of the 
x3850 M2 server.

Click Next.

Figure 2-40   New Virtual Machine Wizard - Installation options
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8. In the summary panel (Figure 2-41), review the choices that you made in the wizard. Click 
Finish to create the VM. The operating system that you selected in step 7 on page 50 is 
installed when the VM is started, as we describe in the next section.

Figure 2-41   New Virtual Machine Wizard - Summary
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2.5.2  Installing a guest operating system

Installation of a guest operating system is a straightforward process. When you start the VM, 
it attempts to boot as though it were residing on real hardware. 

To install a guest operating system, start Hyper-V Manager. Highlight the required VM, 
right-click, and select Start (Figure 2-42).

Figure 2-42   Starting the virtual machine

A new window opens showing the console of the VM (Figure 2-43).

Figure 2-43   Starting the virtual machine
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Assuming that you mapped suitable installation media (ISO or CD/DVD), the guest operating 
system installation proceeds (Figure 2-44).

Figure 2-44   Booting the VM to installation media

The standard installation procedure continues to install the guest operating system, which is 
Windows Vista in our example.

Tip: If you are using RDP/Terminal Services or Remote Supervisor Adapter II to access 
the host desktop, you might lose the ability to use the mouse within the VM connection. 
This behavior is documented in the release notes. However, the fact that the use of the 
mouse in this mode seems to return after Integration Services is installed is omitted from 
the release notes.



54 Implementing Microsoft Hyper-V on IBM System x and IBM BladeCenter

2.5.3  Installing Integration Services on the guest

Integration Services provides updated drivers to the guest operating system. These drivers 
proved extra features to the guest and performance enhancements. The features provided 
depend on the version of guest operating system. The features are enabled or disabled by 
selecting check boxes in the VM properties (Figure 2-45).

Figure 2-45   Properties of the VM related to Integration Services
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To install the Integration Services software, from the guest machine console window, click 
Action → Insert Integration Services Setup Disk (Figure 2-46). This has the effect of 
mounting a virtual optical drive to the VM. If Autorun is not enabled, you might have to select 
the CD to start the installation.

Figure 2-46   Installing Integration Services

SP1 for Windows Vista: Windows Vista requires SP1 to support Integration Services. If 
you attempt to install Integration Services on a system without SP1, you might receive the 
following message: 

The specified program requires a newer version of Windows

If your SP1 media is remote, you might have to install an existing network adapter to the 
VM to temporarily gain network access. After the service pack is applied and Integration 
Services is installed, you can replace adapter with a higher performing network adapter.
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2.5.4  Installing a virtual network

To install the virtual network, in the Virtual Network Manager window (Figure 2-47), under 
Virtual Networks in the left pane, select New virtual network. In the right pane, for type of 
virtual network, select External. Click OK.

Figure 2-47   Creating a new virtual network
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Notice the warning message about temporarily losing connectivity (Figure 2-48).

Figure 2-48   Temporary loss of connectivity



58 Implementing Microsoft Hyper-V on IBM System x and IBM BladeCenter

2.5.5  Adding a virtual network adapter to a guest

In the properties for the VM, add a virtual network adapter to the guest (Figure 2-49). In the 
left pane, expand Hardware → IDE Controller 1 and select Network Adapter General 
external virtual network. In the right pane, select the network. For MAC address, select 
Dynamic. Click Apply and then click OK.

Figure 2-49   Adding the virtual network adapter
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2.5.6  Configuring a firewall for remote administration

To configure the firewall for remote administration, enter the following command 
(Figure 2-50):

netsh advfirewall firewall set rule group="Windows Management Instrumentation 
(WMI)" new enable=yes

Figure 2-50   Configuring a firewall for remote administration

You can verify this rule by using the Windows Firewall with Advanced Security window 
(Figure 2-51).

Figure 2-51   Verifying the firewall rules
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2.5.7  Associating the Hyper-V administrator role with an AD group

By default, the only users with the authority to administer VMs are the members of the local 
Administrators group. In most situations, place this authority in a separate group to allow 
greater granularity of roles.

In our example, the authority to administer VMs is given to the AD group called Hyper-V 
Administrators from the ITSO test labs AD domain. This task is performed within the 
Authority Manager snap-in.

To associate the administrator role with an AD group:

1. Load the snap-in by entering azman.msc at a command prompt.

2. Right-click Authorization Manager and click Open Authorization store. 

3. In the Open Authorization Store window (Figure 2-52), ensure that XML file is selected 
and the name is typed in the Store name field. Click OK.

Figure 2-52   Open Authorization Store window

If you are modifying a local store, enter the following as the store name:

c:\ProgramData\Microsoft\Windows\Hyper-V\initalstore.xml 

Enter the following name if you are modifying a remote store for a remote computer where 
remote computer is the computer name:

remote computer ProgramData\Microsoft\Windows\Hyper-V\initalstore.xml 

Tip: In many cases, ProgramData is a hidden folder and is not displayed if you attempt 
to simply browse to it.
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4. Expand Hyper-V services → Role Assignments. Right-click Administrator and select 
Assign Users and Groups → From Windows and Active Directory (Figure 2-53).

Figure 2-53   Assigning users

5. In the Select Users, Computers, and Groups window, select your new administrative 
group. We added Hyper-V Administrators, which is now displayed in the list in 
Figure 2-54.

Figure 2-54   Hyper-V Administrators group added
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Chapter 3. System management tools

In this chapter, we provide an overview of Hyper-V-related system management. 

This chapter includes the following topics:

� 3.1, “Hyper-V Manager” on page 64
� 3.2, “Microsoft System Center Virtual Machine Manager” on page 65

3
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3.1  Hyper-V Manager

Hyper-V Manager is a Microsoft Management Console (MMC)-based tool for administering 
the Hyper-V feature in Windows Server 2008 or Hyper-V Server 2008. By using this tool, you 
can manage and interact with an installation of Hyper-V from your Windows Vista computer in 
the same manner that you do on a full installation of Windows Server 2008. Note that you 
must have Vista SP1 installed to use Hyper-V Manager. 

Hyper-V Manager is available for download from the Microsoft Web site as part of the 
Windows Vista Service Pack 1 Management Tools update from the following address:

http://support.microsoft.com/?kbid=952627 

Installing the Hyper-V management tools creates a shortcut for the MMC snap-in under the 
“Administrative Tools” folder. However, this folder is not displayed in Windows Vista by default. 
You must enable this folder under the Start Menu properties for it to display: 

1. Right-click the Start button and click Properties.

2. Click the Start Menu tab and click the active Customize button. 

3. Scroll down the list to System administrative tools and click Display on the All 
Programs menu and the Start menu.

4. Click OK.

When you start Hyper-V Manager, you see a window like the example in Figure 3-1.

Figure 3-1   Hyper-V Manager

http://support.microsoft.com/?kbid=952627
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With Hyper-V Manager, you can create, delete, and manage virtual machines (VMs) hosted 
on a single server. With one look, you can see all Hyper-V enabled machines on the left side 
and related VMs in the center section. By using the action bar on the right side, you can 
perform actions to the VMs or to the Hyper-V server.

3.2  Microsoft System Center Virtual Machine Manager

Microsoft System Center Virtual Machine Manager (SCVMM), or simply Virtual Machine 
Manager (VMM), is a management solution for the virtualized data center. VMM enables 
physical server utilization, centralized management of VM infrastructure, and rapid 
provisioning of new VMs by the administrator and authorized users. VMM provides a solution 
for managing the virtual and physical environment. VMM is a comparable product to VMware 
VirtualCenter.

The Virtual Machine Manager 2008 Configuration Analyzer (VMMCA) is a partner diagnostic 
tool that verifies configuration settings for your server that are important to running VMM. For 
more information, see the VMMCA Web site at the following address:

http://www.microsoft.com/downloads/details.aspx?FamilyID=02d83950-c03d-454e-803b-9
6d1c1d5be24&displaylang=en

3.2.1  Features of Virtual Machine Manager

VMM has the following features:

� Allows for the conversion of physical servers to VMs (P2V)

� Allows for the conversion of VMs (V2V)

� Fast provisioning of new VMs

� Automates the guest deployment if running multiple hosts

� Enables central resource management of the resources that you use to create VMs within 
the VMM library

� Allows the creation of new VMs by using templates

� Provides management through Windows PowerShell, the VMM command shell

� Provides reporting by integrating with System Center Operations Manager 2007

For more information, see the Virtual Machine Manager FAQ available from the following 
address:

http://technet.microsoft.com/en-us/library/bb740760.aspx

Figure 3-2 on page 66 shows the test environment scenario for setting up an SCVMM. 
Microsoft SQL Server 2005 Express edition is installed locally. When setting up SCVMM, use 
a dedicated IBM System x server to guarantee the best performance. The SCVMM SQL 
Server database can be deployed locally or to a dedicated system running SQL Server. At the 
time at which this paper was written, Microsoft did not support SQL Server 2008 in this 
configuration. 

http://www.microsoft.com/downloads/details.aspx?FamilyID=02d83950-c03d-454e-803b-96d1c1d5be24&displaylang=en
http://technet.microsoft.com/en-us/library/bb740760.aspx
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Figure 3-2   System Center Virtual Machine Manager configuration

Although the VMM server cannot be clustered, the SQL database can be deployed to a 
clustered environment and the VMM server can be installed on a highly available VM. For 
more information, see Planning for the VMM Server at the following address:

http://technet.microsoft.com/en-us/library/cc764331.aspx

While this installation does not provide high availability, SCVMM can be rapidly redeployed if 
SCVMM backups are scheduled by either using a Windows system state backup, using 
Backup-VMMserver cmdlet, or doing backups through the VMM Administrative GUI. To back 
up the VMM database, you can use the following PowerShell command:

Backup-VMMServer -path \\server\share -VMMServer yourscvmmserver

Tip: The SQL Server 2005 Express Edition SP2 database size is limited to 4 GB. 
Therefore, use a full version of SQL Server when the VMM server is managing more than 
150 hosts. You can find the system requirements at the following address:

http://www.microsoft.com/systemcenter/virtualmachinemanager/en/us/system-requir
ements.aspx 
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If using SQL 2005 Express edition, schedule maintenance for your database. For more 
information, see Managing SQL Server Express with SQL Server 2005 Management Studio 
Express Edition at the following address: 

http://www.microsoft.com/technet/prodtechnol/sql/2005/mgsqlexpwssmse.mspx

You can download SQL Server 2005 Management Studio Express Edition from the following 
address:

http://www.microsoft.com/downloads/details.aspx?familyid=C243A5AE-4BD1-4E3D-94B8-5
A0F62BF7796&displaylang=en

SQL Server 2005 Management Studio Express is not supported on Windows Server 2008. If 
you are installing management studio in an administration workstation, see Microsoft article 
KB914277, “How to configure SQL Server 2005 to allow remote connections” at the following 
address: 

http://support.microsoft.com/kb/914277

3.2.2  Virtual Machine Manager hardware requirements

The minimum and recommended hardware requirements to install and operate all VMM 
components on a single computer are listed in the following tables based on the number of 
hosts that you manage. For more information about system requirements, see the following 
Web page:

http://www.microsoft.com/systemcenter/virtualmachinemanager/en/us/system-requireme
nts.aspx 

When sizing the VMM system, concentrate on hard disk and network capacity. Microsoft 
recommends having 80 GB-150 GB of available disk space. The size of the required disk 
space depends on the following criteria:

� The number of virtual hard disks (VHDs) or VM templates that you are going to build into 
the library

� Whether you save many different type VMs in the VMM library

� The number of CD images that you are going to store in your library

Table 3-1 shows the server requirements for managing up to 10 hosts.

Table 3-1   Server requirements when managing up to 10 hosts

Table 3-2 shows the server requirements for managing up to 20 hosts.

Table 3-2   Server requirements when managing up to 20 hosts

Hardware component Minimum Recommended

Processor Pentium® 4 2 GHz Dual-Core Pentium 4™ 3.2 GHz or greater

RAM 2 GB 2 GB

Hard disk 80 GB 150 GB

Hardware component Minimum Recommended

Processor Pentium 4 2.8 GHz Dual-Core Pentium 4 3.2 GHz or greater

RAM 2 GB 4 GB

Hard disk 150 GB 200 GB

http://www.microsoft.com/technet/prodtechnol/sql/2005/mgsqlexpwssmse.mspx
http://www.microsoft.com/downloads/details.aspx?familyid=C243A5AE-4BD1-4E3D-94B8-5A0F62BF7796&displaylang=en
http://support.microsoft.com/kb/914277
http://www.microsoft.com/systemcenter/virtualmachinemanager/en/us/system-requirements.aspx
http://www.microsoft.com/systemcenter/virtualmachinemanager/en/us/system-requirements.aspx
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If you plan to host the VMM server on a dedicated system, the hardware listed in Table 3-3 is 
required, depending on the number of hosts that you plan to manage.

Table 3-3   Managing up to 150 hosts - Dedicated server

The SQL Server 2005 Express Edition SP2 database size is limited to 4 GB. Therefore, use a 
full version of SQL Server when the VMM server is managing more than 150 hosts. 

Table 3-4   Managing more than 150 hosts

3.2.3  Installing the Virtual Machine Manager server

In this section, we explain how to install VMM on a single computer. We install the VMM 
server and the standalone SQL 2005 Express Edition product. 

To install the server:

1. Purchase the software or download a trial version from the following address:

http://www.microsoft.com/systemcenter/virtualmachinemanager 

Hardware component Minimum Recommended

Processor Pentium 4, 2 GHz (x64) Dual Processor, Dual Core, 2 GHz 
(x64) or greater

RAM 2 GB 4 GB

Hard disk space with remote 
database

2 GB 50 GB

Hard disk space (with the default 
local SQL Server 2005 Express 
Edition SP2 database installed)

10 GB Note: For the default local SQL Server 
2005 Express Edition SP2, the 
database size is limited to 4 GB.

Hardware component Minimum Recommended

Processor Pentium 4, 2.8 GHz (x64) Dual Processor, Dual Core, 3.6 GHz or 
greater (x64)

RAM 4 GB 8 GB

Hard disk space 10 GB 50 GB

http://www.microsoft.com/systemcenter/virtualmachinemanager
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2. Run the installer. Click through the opening windows, including the license. It checks the 
hardware and software that are installed on your system against the system requirements 
as shown in Figure 3-3. Click Next to continue.

Figure 3-3   Virtual Machine Manager installation - Checking the prerequisites
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3. In the Installation Location panel (Figure 3-4), select the path where you want to install the 
application files and click Next.

Figure 3-4   Virtual Machine Manager installation - Location of files
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4. In the SQL Server Settings panel (Figure 3-5), select whether you want to use SQL 2005 
Express edition or an existing SQL installation. Click Next.

Figure 3-5   Virtual Machine Manager installation - SQL Server settings
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5. In the Library Share Settings panel (Figure 3-6), specify the library share name to keep all 
library items (VHDs, ISO files, and so on), or use an existing network share as a library. 
Click Next.

Figure 3-6   Virtual Machine Manager installation - Library share settings

6. In the Administrators Properties window (Figure 3-7), add a Virtual Machine Manager 
service user account to the local administrators group. Then click OK.

Figure 3-7   Virtual Machine Manager installation - Adding the VMM service user account to the local 
administrators group
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7. In the Installation Settings panel (Figure 3-8), specify the ports that are used for 
communication. Do not use the default values. Specify the VMM service account to be 
used. If Windows Firewall is in use, the wizard adds rules for each port. 

Click Next.

Figure 3-8   Virtual Machine Manager installation - Ports and VMM service account

3.2.4  Installing the Virtual Machine Manager Administrator Console

The Virtual Machine Manager Administrator Console can be installed on an administrator’s 
workstations or it can be on same server as VMM. However, if you plan to use the monitoring 
or reporting functions of VMM, you must install the Virtual Machine Manager Administrator 
Console on the same machine as the VMM to enable Operations Manager administrators to 
perform tasks on hosts and VMs.

For the hardware requirements, see the following address:

http://technet.microsoft.com/en-us/library/cc764321.aspx 

http://technet.microsoft.com/en-us/library/cc764321.aspx


74 Implementing Microsoft Hyper-V on IBM System x and IBM BladeCenter

To install the Virtual Machine Manager Administrator Console from the SCVMM 2008 
installation media:

1. Start the setup, which checks all prerequisites as shown in Figure 3-9. Click Next.

Figure 3-9   Virtual Machine Manager Administrator Console installation - Prerequisites check
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2. Specify the installation location of the program files.

3. In the Port Assignment panel (Figure 3-10), enter the same port that was defined earlier 
when you installed the server. Click Next.

Figure 3-10   Virtual Machine Manager Administrator Console installation - Port assignment
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4. In the Summary of Settings panel (Figure 3-11), review the summary of the settings and 
click Install to perform the installation.

Figure 3-11   Virtual Machine Manager Administrator Console installation - Summary

5. Optional: After the installation is complete, check online for the latest updates to VMM. 
The installer then exits.

6. When you launch the Virtual Machine Manager Administrator Console, when prompted, 
enter the address and port number for the VMM server (Figure 3-12). Click Connect.

Figure 3-12   Connecting to the VMM server
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When successful, you see the main window (Figure 3-13).

Figure 3-13   Virtual Machine Manager Administrator Console 

To manage hosts and VMs, you must add a host to the VMM environment. If you completed 
all the steps correctly, the VMM server automatically installs the SCVMM agent to the host 
server.

3.2.5  Installing the System Center Virtual Machine Manager Self-Service Portal

The System Center Virtual Machine Manager 2008 Self-Service Portal is an optional, 
Web-based component with which users can create and manage their own VMs within a 
controlled environment. With the SCVMM Self-Service Portal, you can perform the following 
tasks:

� Create and delete VMs (SCVMM library also available)
� Start and stop VMs
� Pause VMs
� Shut down VMs
� Connect to the console or start remote desktop management
� Configure the VM properties

To learn about the hardware and software requirements for the VMM Self-Service Portal, see 
the following address: 

http://technet.microsoft.com/en-us/library/cc764309.aspx

http://technet.microsoft.com/en-us/library/cc764309.aspx
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Install the System Center Virtual Machine Manager Self-Service Portal by using the SCVMM 
2008 installation media:

1. Begin the installation and agree to the license terms. 

2. In the Microsoft Update panel (Figure 3-14), specify whether you want to check for online 
updates. Click Next.

Figure 3-14   SCVMM Self-Service Portal - Installation

3. In the next panel, in which the installer checks the hardware and software prerequisites, 
click Next.

4. When prompted, specify a folder for installing the code or accept the default. Click Next. 
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5. In the Web Server Settings panel (Figure 3-15):

a. Specify the address of the VMM server and the listening TCP port (defined during the 
setup of VMM). 

b. Set up the TCP port where the Self-Service Portal answers to http requests. Do not 
use default http port (80) for security purposes. The Windows Firewall, if enabled, is 
automatically configured with an exception.

c. Click Next.

Figure 3-15   SCVMM Self-Service Portal - Web settings

6. In the summary panel of the installation options, click Install to begin the installation.

Managing the SCVMM Self-Service Portal user permissions
Before SCVMM users can log into the Self-Service Portal, the SCVMM administrator must 
give permission to manage the VMs:

1. Open the SCVMM Administrator Console.

2. Click Administration → User Roles. 

3. Double-click Self-service-portal-User. 

4. In the properties window (not shown), click the Members tab and add the users that you 
want to have access to the tool. Click OK to save the changes.

In the Self-Service Portal, you can perform a limited number of actions to VMs. However, it is 
still a useful tool for doing quick operations or delegating VM access to a third-party 
administrator without needing to give them a full view of the Hyper-V server. 
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Figure 3-16 shows the login panel for the Self-Service Portal.

Figure 3-16   SCVMM Self-Service Portal login panel

Figure 3-17 shows the Self-Service Portal.

Figure 3-17   Self-service portal
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Chapter 4. High availability solutions with 
Hyper-V and System x

In this chapter, we discuss the following topics about improving the availability of a system 
through the use of Hyper-V:

� 4.1, “IBM Storage Solutions for Microsoft Hyper-V” on page 82
� 4.2, “Quick Migration with Hyper-V” on page 82

4
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4.1  IBM Storage Solutions for Microsoft Hyper-V

A virtualized server environment helps to improve the efficiency of your computing resources 
by using your hardware resources more efficiently and fully. With Microsoft Hyper-V and 
Windows Server 2008, organizations are equipped to streamline their IT infrastructure and 
take advantage of the more efficient storage and server solutions that IBM offers. By using 
Microsoft Hyper-V, you can create and manage a virtualized server computing environment 
and help your organization improve efficiency and reduce costs. To complete the solution, 
IBM System Storage™ provides the high performing, scalable, reliable, available, and flexible 
midrange storage systems that are needed to support the Microsoft Hyper-V information 
infrastructure.

Hyper-V virtual servers run as cluster resources and automatically fail over if one host node is 
unavailable. These virtual machines (VMs) can also be quickly migrated between the cluster 
nodes, pausing running applications and resuming automatically once online. In a disaster 
recovery event, replicated logical unit numbers (LUNs) and guests are manually activated and 
brought online.

IBM offers industry leading storage virtualization to help provide a complete, end-to-end 
virtualized information infrastructure, complementing Hyper-V server virtualization. With the 
high-performing IBM SAN Volume controller, customers can virtualize their Microsoft storage 
environment. SAN Volume Controller combines the capacity of multiple disk storage 
controllers into a single storage resource. These disk controllers can be from many different 
vendor companies. From a single resource, operators can apply copy services across all the 
disk controllers in this resource and perform point-in-time copies (FlashCopy®) or replicate 
data by using Metro Mirror or Global Mirror. SAN Volume Controller also has the ability to 
perform many tasks within the storage infrastructure by using the data that is stored on the 
disk controllers, without disrupting the Microsoft platform.

When putting together both IBM Storage and Microsoft Hyper-V, Microsoft Hyper-V users 
benefit from a new era of affordable application virtualization to companies of all sizes. This 
combination offers organizations new opportunities for increased resource utilization, ease of 
management, and improved return of investment. IBM has worked closely with Microsoft to 
help ensure that our products are optimized for Hyper-V deployments. Together with the new 
IBM System Storage DS5000, or by adding SAN Volume Controller to virtualize a multivendor 
storage environment, the ability for companies of all sizes to efficiently implement a highly 
available and disaster-tolerant computing environment continues to improve.

4.2  Quick Migration with Hyper-V

Hyper-V provides customers the ability to reduce the cost of expected and unexpected 
downtime through Quick Migration, helping them to meet stringent uptime and response 
metrics. In this section, we describe how we implemented this feature.

In our lab, we ran a system as a guest VM on a physical server and configured the physical 
server as a node in a failover cluster. The virtual hard disk (VHD) of the guest VM was made 
available to all nodes in the cluster by using shared storage. 

Quick Migration saves the state of the running guest operating system, logically moves the 
storage connectivity from one node to another, and restores the guest operating system onto 
the second server. The speed of migration depends on the amount of memory needed to be 
written to disk and the speed of connectivity to storage, but is usually measured in seconds. 
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Figure 4-1 shows the setup for our cluster. Two nodes (physical servers) are connected to 
domain controllers, printers, and routers by using the public network. A private network is 
used for cluster-related network traffic only, and it helps the cluster nodes verify the state of 
the others nodes.

Figure 4-1   Layout of our cluster for migration

The system requirements include hardware, network, and storage requirements for a quick 
migration scenario as follows:

� The system need a Domain Name System (DNS), DNS dynamic update protocol, or 
Windows Internet Naming Service (WINS).

� Nodes in the cluster are in the same Active Directory domain and in the same domain role.

� Nodes in the cluster have the same hardware resource and processor architecture.

� An Intel VT or AMD-V processor is required.

� Hardware components must be compatible with cluster technology because failover 
cluster is installed on a storage area network (SAN).

� CPU speed is at least 1.0 GHz for each guest operating system.

� Total hard disk space of 2 GB is required on each node.

� For each guest operating system, 512 MB RAM is required.
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� Each of two cluster nodes must have at least two network adapters and is connected by 
two independent networks.

– These two nodes must be able to access the Active Directory domain. The domain 
controller is in the same local area network (LAN) as these two nodes.

– These two nodes must be connected to an external disk storage that is used as the 
cluster storage. If using iSCSI, each node needs a network adapter connected to this 
external storage. 

� The file system of the shared storage must be NTFS and is configured as a 
shared-nothing configuration.

By using Quick Migration, users can migrate a running VM from one physical host to another 
by taking advantage of the high availability function of Windows Server and Microsoft System 
Center management tools. Windows Server 2008 sees the VHD files that make up the VMs 
on the LUNs. The Windows cluster administrator can also work with the LUNs and the VMs 
running on those LUNs. This is one of the benefits of Windows Server 2008, thereby making 
the migration of VMs faster and easier. 

In Windows Server 2008 Enterprise and Data Center, users can run each server that 
provides client services as a guest VM on a physical server and configure the physical server 
as a node in a failover cluster. In addition, users can make the VHD of the guest VMs 
available to the other nodes with the cluster, so that each server that provides client services 
now runs as a highly available VM.

For a planned migration, Quick Migration saves the state of a running guest VM, moves the 
storage connectivity from one physical server to another, and then restores the guest VM onto 
the second server. The speed of the migration depends on how much memory must be 
written to disk and on the speed of the connectivity to storage. Generally migration takes a 
few seconds. However, in the case of unplanned migration, the images written to the disk are 
failed over from the shared storage automatically.

After a cluster is set up and the VM is online, users can use Quick Migration to quickly move it 
between physical host servers. Hyper-V Manager provides information about host servers. 
Users can discover which VM runs on which physical host server in this Hyper-V Manager 
console. 

Quick Migration entails the following actions:

1. Open the Failover Cluster Management console in which users can see the VMs running 
on the individual nodes.

2. Highlight a VM to provide a summary of its properties.

3. Right-click the VM name. From the Actions menu, users can see the option to move the 
VM from one node to another node. Users can choose the destination node.

4. After the task is run, the VM enters a pending state before it is moved.

5. After a few seconds, the VM is displayed on the destination node, and the status returns to 
Online. 

The Quick Migration is now completed.
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AD Active Directory

AMD Advanced Micro Devices

API application programming interface

BIOS Basic Input/Output System

CD compact disk

COM Component Object Model

CPU central processing unit

CSV comma separated variable

DAS Direct Attached Storage

DHCP Dynamic Host Configuration 
Protocol

DNS Domain Name System

FAQ frequently asked questions

FTP File Transfer Protocol

GA general availability

GB gigabyte

GUI graphical user interface

HPC high performance computing

I/O input/output

IBM International Business Machines

ID identifier

IIS Internet Information Server

IP Internet Protocol

ISO International Organization for 
Standards

IT information technology

ITSO International Technical Support 
Organization

JVM Java virtual machine

LAN local area network

LUN logical unit number

MB megabyte

MMC Microsoft Management Console

MSDN Microsoft Developer Network

NAP Network Access Protection

NAS network attached storage

NAT Network Address Translation

NTFS NT File System

P2V physical servers to VMs

PATA parallel ATA

PC personal computer

Abbreviations and acronyms

RAID redundant array of independent 
disks

RAM random access memory

RDP Remote Desktop Protocol

RODC Read-only Domain Controller

SAN storage area network

SAS Serial Attached SCSI

SATA Serial ATA

SCSI Small Computer System Interface

SCVMM System Center Virtual Machine 
Manager

SMB Server Message Block

SQL Structured Query Language

TCB trusted computing base

TCP Transmission Control Protocol

UI user interface

USB universal serial bus

V2V VM

VHD virtual hard disk

VLAN virtual LAN

VM virtual machine

VMM Virtual Machine Manager

VMMCA Virtual Machine Manager 2008 
Configuration Analyzer

VSS Volume Shadow Copy Services

VT Virtualization Technology

WINS Windows Internet Naming Service

WMS Windows Media Services

WOW Windows on Windows

XML Extensible Markup Language
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Related publications

The publications listed in this section are considered particularly suitable for a more detailed 
discussion of the topics covered in this paper.

IBM Redbooks

For information about ordering these publications, see “How to get Redbooks” on page 88. 
Note that some of the documents referenced here may be available in softcopy only. 

� Planning, Installing, and Managing the IBM System x3950 M2, SG24-7630

� Running Microsoft SQL Server 2008 on the IBM System x3950 M2, REDP-4476

Online resources

These Web sites are also relevant as further information sources:

� Hyper-V Server 

http://www.microsoft.com/servers/hyper-v-server/ 

� Windows Server 2008

http://www.microsoft.com/windowsserver2008/ 

� Supported guest operating systems

http://support.microsoft.com/kb/954958 

� Windows Server Catalog: Server hardware certified by Microsoft to run Hyper-V

http://go.microsoft.com/fwlink/?LinkID=111228 

� Hyper-V management tools 

http://support.microsoft.com/kb/952627 

� Fixes to the general availability (GA) release of Windows Server 2008 including updates 
that were made available after GA of Hyper-V

http://support.microsoft.com/kb/950050 

� Microsoft Remote Server Administrative Tool

http://support.microsoft.com/kb/941314 

http://support.microsoft.com/kb/954958
http://go.microsoft.com/fwlink/?LinkID=111228
http://www.microsoft.com/servers/hyper-v-server/
http://www.microsoft.com/windowsserver2008/
http://support.microsoft.com/kb/941314
http://support.microsoft.com/kb/952627
http://support.microsoft.com/kb/950050
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How to get Redbooks

You can search for, view, or download Redbooks, Redpapers, Technotes, draft publications 
and Additional materials, as well as order hardcopy Redbooks publications, at this Web site: 

ibm.com/redbooks

Help from IBM

IBM Support and downloads

ibm.com/support

IBM Global Services

ibm.com/services

http://www.redbooks.ibm.com/
http://www.redbooks.ibm.com/
http://www.ibm.com/support/
http://www.ibm.com/support/
http://www.ibm.com/services/
http://www.ibm.com/services/
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